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‘('9‘!") CASOS _ _ _
J) Engineering Previous Work with Loki-Infect

. Loki-Infect versions 1 and 2 have been used in a
variety of infectious disease modeling studies:

Sandia
National  H§
Laboratories "%,

Glass et al. (2006): determined the critical importance of children in
influenza epidemic propagation. Closing schools and social distancing of
children reduced infections by 90%.

Davey et al. (2008): evaluated thresholds for rescinding community
mitigation strategies.

Glass & Glass (2008): surveyed children and teenagers found teens
had most contacts that could serve as influenza transmission ‘backbone’.

Davey & Glass (2008): a systematic evaluation of feasible mitigation
strategies at wide range of pandemic severities and found critical enablers of
success—rapid, stringent, regional implementation with high compliance.

Perlroth et al. (2009): evaluated cost-effectiveness of mitigation
strategies, finding that the addition of school closure to adult and child social
distancing and antiviral treatment and prophylaxis is not cost-effective for
viral strains with low infectivity (Ro 1.6 and below) and low case fatality rates
(1% and below).
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&Y =roneein Objectives for Loki-Infect 3

. Loki-Infect 3 Is a desktop application intended for
use by community-level decision makers.

. It allows rapid construction of small-scale studies of
emerging or hypothetical infectious diseases in their
communities and evaluation of the potential
effectiveness of various containment strategies.

. It was designed with an emphasis on modularity,
portability, and ease of use.

. Our goal is to make this program freely available to
community workers across the world.
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#8) coqincering Loki-Infect Graphical User Interface allows

users to easily create a propagation network

Loki-Infect 3.0.0b5

File Edit Community Virus

Interventions Simulate Help
Info 2 - X

Loki Infect

Welcome to the Loki Environment

s To get started click File -> New -> Complete Simulation Environment
« The Community Parameters tab is used to set up your community, the people in it and their connections.
« The Infections tab can be used to modify the parameters of the infection that will run through the community.

« The Interventions tab can be used to select and modify different interventions that will go into effect at specified
times.

« For more information about the Loki Environment you can access the Wiki by clicking Help -> Resources

« If you hover your mouse over different text you can find more details about the specific parameters you can change.

« You can return to this view at any time by clicking Help -> Getting Started
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) cngineering Representation of a Community

. A community is described by a set of layers, such as a family
layer, a friend layer, or a classroom layer.

. Each layer contains a number of groups, which represent, e.qg.,
iIndividual families, friendship groups, or classrooms.

. A person is represented by a node, which can be a member of
multiple different groups.

Extended family
or neighborhood

®
Teenager random

Household { ® ®
@]
. [ ]
— Social -~ &E °

networks
for teenager 1

.
L8\
Everyone random L
School classes ®
Q)

(6 like this) y
@ Child |
@ Teenager . y
@ Adult “ %Y
@ Older adult ) ’_. ._. /
-0
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CASOS Users can begin with a blank community,
Engineering - . . .
building it from scratch to suit their needs...

B Loki-Infect 3.0.0b5

File Edit Community Virus Interventions Simulate Help

Test Community # = X A _0Ox

Name: |Tes{ Commurnity |

Total Population:  [1000 |

Age Classes: Mames Percent of Total Population Mumber

Totals: 0.00 0]

Metwark Group Age Claszes Group Diztribution | | | Idin (NS Mean Freguency Dration Irtersity Metwaork Type
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CASo0S

Or users can begin with a predefined community
that reflects basic contact networks for a model

10000-member community

File Edit Community Virus Interventions Simulate Help
Default Community # — X R =
Name: |Default Community |
Total Population: [10,000 |
Age Classes: Mames Percent of Total Population Mumber
Aclufts 555 58350
Children 17.7 1770
Teens 1473 1130
Seniors 125 1250
Totals: 100.00 10000
Metwiork Graup Age Clazzes Group Distribution | | | hoiny Bz Mean Freguency Dur ation Irtenzity Metwiark Type
[Mon-Senior Households Adults Uniform Distribution s 1 2| 1.5 1 Complete Metwork F
Chilclren Exponential Distribution a 4 1.0
Teens Exponential Distribution o 4 1.0
Senior Households Seniors Uniform Distribution ) s 1 2 1.4 1 Complete Metwark LY
Extended Families or ... Seniors Uniform Distribution ) s 1] 2 1.0 1 (Complete Metvwark LY
Adults Exponertisl Distribution 1] = 3.0
Teens Exponential Distribution o g 4.0
Chilclren Exponential Distribution o g 4.0
Child Classes Children Uniform Distribution LRI ™ 20 35 275 1 Ring Metweark oy
Child Random Children Constart Distribution ) s 1,770 1,770 17700 1 Rancom Metwark &y
Teen Class 1 Teensz Uniform Distribution ) s 20 35 275 1 Ring Metwork P
Teen Class 2 Teens Uniform Distribution L g™ 20 35 275 1 Ring Metweark oy
Teen Class 3 Teens Uniform Distribution LRI ™ 20 35 275 1 Ring Metweark oy
Teen Class 4 Teensz Uniform Distribution ) s 20 ) 2T5 1 Ring Metwark &y
Teen Class 5 Teensz Uniform Distribution & s 20 35 275 1 Ring Metwork P
Teen Class 6 Teens Uniform Distribution L g™ 20 35 275 1 Ring Metweark oy
Teen Random Teens Constart Distribution ) s 1,130 1,130 11300 1 Ranclom Metwark L
-
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File Edit Community Virus

Individual cells can be edited to update the entire
population, or only a portion of it

Interventions Simulate Help

Default Community # — }E‘\
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Name: Default Community
Total Population: (10,000
Age Classes: Mames Percent of Total Populstion Mumkber
Adults 58.5 S50
Children 17.7 1770
Teens 143 1130
SEniars 12.5 1250
Totals: 100.00 10000
Metwork Group Age Clazzes izroup Distribution hin i Mean Fre
Mon-Senior Households Aduts Unifarm Distribution & i 1 2 1.5
Zhildren Exponertial Distribution 0 4 1.0
Teens Exponential Distribution 0 4 1.0
Lo P I O e Y PN L e Pt I Imif e Fiaedwil-o i i e 4 | 4 £
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~“E}) CASOS Members of a layer and how they're
S distributed in groups in the layer can
be configured

Additional layers
over the population
can be constructed

%

Metweark Group Age Claszes iZroup Distribution flir i Mean
Mon-Zenior Households Adults Uniform Distribution BT 1 2 1.5
Children Exponential Distribwudion 0 4 1.0
Teens Exponertial Distribution 0 4 1.0
=enior Houzeholds =eniors Uniform Distribution ) L 1 2 15
Extended Families or ... Seniors Uniform Distribution & L 0 2 1.0
Adults Exponertial Distribudion 0 ] 3.0
Teens Exponential Distribwudion 0 o] 4.0
Children Exponertial Distribution 0 & 4.0
Child Classes Children Uniform Distribution L 20 30 275
Sandia 4% &
@ National A VEter.anS He.alth Modeling for Public Health Action
Laboratories % Administration 9- 10 December 2010 9




CASOS Graphs of the distributions of groups upon
s constructing a given layer can be requested
by clicking the appropriate icon

Metweork Group Age Claszes Group Distribution | | | lin [l =% Mean Freguency Dration Irtensity Metwwork Type |
Mon-Senior Househalds | Adults nifarm Distribution e 1 2| 15 5] 1 1 Complete Metwork &y
Children Exponential Distribution o 4 1.0
Teensz Exponential Distribution 1] 4 1.0
£:) Man-Senior Househo L5 £ Mo £ pusehold
Hon-Senior Households ¢ x\ Fl = Hon-Senior Households ¢ X’\ ¢ Ox
Non-Senior Households Non-Senior Households
2
A=2 0=1,T=2: (14, 2,200
bt 2,250
A=2.0=2.T=2: (7,
0% 2,000
A=2,0=3,T=2: (2,
ol _ 1750
x i fen
s, ! A=2,0=4,T=2.(2, 3 1,500
0%) =]
| . —— L
=, f i A=2,C=1,T=1: (142, a 1,250
[A=2,T=2:(52, 1%) ik 3 ..
A=1,0=4,T=1:(1, A=1,0=1,T=2: (13, .@ 1,000
0% 0%)
A=1,0=2,T=1: (24, 730
| A=2,0=2 T=1: (58,
£A=1,0=3,T=1: (10, 2%) 500
e ' A=1.0=2,T=2: (3,
A=2,0=3,T=1: (13, V. 4 0%) 250
0% e
0%) r — : : = : : : -
A=2.C=4.T=1(8, 0.0 0.5 1.0 15 2.0 2.5 2.0 3.5 4.0
0% A=1: (541, 15%) Members
A=1,C=1,T=1: (BB, I
=) == cluilts =*@=Children “0=Teens i
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.‘(.\‘ CAS0S
&Y cronein Representation of a Community

. Finally, for each layer in a community, the user provides an
Idealized network topology (and any parameters for that
topology) for each group in the layer.

. Supported topologies include: Adults 0 Aduits 1

~ Scale-Free (Barabasi)

- Random (Erdés—Rényi) | [

_ Small-World (Strogatz) Children 1 Children 0
- Ring

- Bipartite Teens 0

- Cycles of Cliques

.- The resulting community is a network of networks, where each
node is a member of multiple different sub-networks.
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CASoS .
Engiﬂeermg Example group topology:

Idealized cycle of cliques

Teen Random # x\ ¢ 0Ox
“Wipe
Teen Random T _—
Network type: e
- (TEenEA

|Cyu:le of Cligues Metwark w || TR

Select JeEms

Eipartite Metvwork " Teene®

Complete Metwork

Cycle of Cligues Metwork AR s

Fandom hetwiork b T
| | Ring Metwork T

Srmiall World Network RE edie 1l
| | ScaleFree

P R g e
| 1 1 Ring Metwoaork
| 1 1 [Ring Metywork gemegy TR
T
| 1 1 Ring Metwoark
T
I 1 1|Cycle of Cliguss Net. i ‘_-
R femnead ifesnEil
| 1 1 Ring Metwark
(Tedrs T TEans a0 BT e
| 1 1 Randaom Metwark TR
eens

| 1 1 Ring Metwork
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e/ o scale-free network over a
population of 1000
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CASo0S
Engineering

The entire network structure for a
community can be exported to the
GraphML format

Network colored
by age classes

Same network colored by node degree
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‘(4# CAS0S _
&Y =roneein Models of Contagion

. Loki-Infect 3 allows the user to simulate different or multiple
contagions on the same social network.

. Currently we have implemented an influenza model developed
by Davey et al. between 2006 and 2009 within the context of
Loki-Infect 3.

- We are also currently working with Danilo Scepanovic of MIT to
Implement an alternative manifestation of influenza that is more
biologically realistic.

. Loki-Infect 3 is also being adapted to model the spread of
opinions and behaviors along social networks.

¢% Veterans Health
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CASo0S

Engineering Davey et al. Influenza Manifestation

. In the influenza manifestation by Davey et al., each edge in the
social network represents a potential contact between two
people with an associated contact frequency, duration, and

intensity.

. Individuals progress through a probabilistic state machine, either
remaining susceptible, or becoming infectious and later
recovering or dying from the infection. The infection spreads
through individual contact.

Latent
Mean duration
1.25 days

Transition
probabilities
psS=0.5
pH=0.5
pM =0

Sandia
National

FNgkh veterans Heartn
Laboratories

¢ Administration

Cx

Infectious symptomatic
Circulate
Mean duration 1.5 days

& Iz 1.0 for first 0.5 day,
Infectious A then reduced to

presymptomatic 0.375 for final day

Mean duration .
0.5 days *»* | Infectious symptomatic
I 0.25 Stay home

Mean duration 1.5 days
I 1.0 for first 0.5 day,
then reduced to
0.375 for final day

Infectious asymptomatic
Mean duration 2 days
I,0.25

LA
=4
Died
F”'
7.
L
Immune

Modeling for Public Health Action
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@ Enginering Davey et al. Influenza Manifestation

. This influenza model has a small, yet descriptive, parameter set,
which can be configured though the GUI and used to represent
a number of influenza manifestations

B Loki-Infect 3.0.0b5

File Edit Community Virus Interventions Simulate Help
n’[erveniions w'(kSimulaﬁun -\\ f 0%
Default Community - Name of infection: Bazic Influenza |
P Easic Influsnza i el ' |
Base Infectnity: 019
Proh. Symptomatic: 0s
Prob. Stay at Home: 0
Mortality: ooz
IDF: 10
Relative Infectivities: Seniors Adults Children Teens
1.0 1.0 1.5 1.25
nitial Infection Pool
istribution: [ Constant distrioution o
lue: | 100
Sandia AN v
. 4 VVeterans Health . . .
@ National ~ §A - . Modeling for Public Health Action 17
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@) CASOS Infections

)/ Engineering

Different models for spreading an infection can be selected,
and details for that model displayed and editable

Name of infection: Bazic Influenza
Infection model: Bavey Itluanzs b

Base Infectiity: 0149

Prob. Symptomatic: |5
Prob. Stay at Home: |5

Mortality: ooz
IDF: 1.0
Relative Infectivities: Seniars Adults Children Teens
1.0 1.0 HpAe, 1.25
nitial Infection Pool
istribution: | Constart distribution i
lue: | 100

A simulation can begin with a distributions of people chosen
from the population to be Initially infected

8 Veterans Health

Sandia A% &0
National —~ H§8& 5 o Modeling for Public Health Action o
Laboratories 75 Administration 9 - 10 December 2010 1



CASo0S

) Engineering Interve ntIOnS

. There are two primary categories of interventions: case-based
and network-based.

. Network-based interventions, such as school closures and
social distancing, take effect immediately for all relevant nodes.

[Defauﬂ Cammunity Infections _j’lnteruentinns =X %imulatic-n 5 A aOx

|Defau|t Commnity 'l Name: |Child-Teen zocial distancing |
Over-all interventions Intervention: | Generic frequency scaling s |
[ antiviral Start Cases: |1D |
[ athome | |
Stop Cases: 0
[ habysitter £
|j guarantine Frequency Scaling: Adults Children Teens Seniors
D Child-Teen social distancing Man-Senicr Households 2 2
[ echagiici Senior Househalds
SENIOIZZOIIE Extencled Families or ... 041 01
[ mdut-Senior socisl distancing Child Classes
[ (no name) Child Randot 01
Teen Class 1

Teen Class 2

Teen Class 3

Teen Class 4
Teen Class 5
Teen Class 6
Teen Random 0.1
Aciult WViiork
Adult Randam
Senior Gathering
Senior Random

EVErYOnE 01 0.1
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‘(’? 3 CASOS :
@ Engi(r)1eering |ﬂterventhnS

. Case-based interventions include actions such as antiviral
treatment and prophylaxis, which reduce a node’s infectivity and
susceptibility for the duration of antiviral administration.

. Case-based interventions apply only to new cases that emerge.

Name: |arrtivira| |
Intervention: | A rtiviral - |
Entry State: | int aympathome - |
Exit State: | - |
Start Cases: |1 0 |
Stop Cases: ||:| |
Entry Probabilities: Groaup Prabakility

ENErYOnE 0s
Prophylaxis groups: Group Prokability

Senior Houzeholds 0.65

- _==—R———.>.>..B.... - B B - — — . ]».».}9}».»9».
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Eg\;ﬁ;rmg In the simulate window, you can perform multiple
runs, and filter the data you wish to view

File Edit Community Virus Interventions Simulate Help

Detaull Commurity. nfections \nterventions | Simulation # — X s_Ox
‘ Detault Communty - | I“fectio“
Outcome variables:
10,000
[ Currert number of peaple nict receiving artivirals.
9,500
[ current number of peaple receiving antivirals 9,000
[ Currert latert cases: 8,500
[T current asymptomatic cazes. 8,000
7,500
[ Current presymptomatic cases
7,000
[ Current circulating cases in syptomatic stage 1
6,500
[7] Currert sirculating cases in symptomatic stage 2. 6,000
=
[7] Currert non-circulating cases in symptomatic stage 1 9 5,500
L)
=
=
[ current non-ciruclsting cases in symptomatic stage 2 —9 5,000
& 4,500
[ Cumulstive cases of mortslity resutting from infection
4,000
[T cumuistive numper of resistant persans.
3,500
[0 Current number of peaple circulating 3,000
[ Current number of peaple ot circulating 2,500
[Z] Current number of susceptible persons. 2,000
1,500
[¥] Current number of infected persons (ir any stage).
1,000
[¥] Current number of recovered or dead persons
500
Other Options:
0
0.0 325 35.0 37.5 40.0 42.5 45.0
[0 Display Means
Number of runs:
~—Set 1 Run 1 sir.resistant ==Set 1 Run 1 sir.infected Set 1 Run 2 sir.resistant Set 1 Run 2 sir.infected == Set 1 Run 3 sir.resistant Set 1 Run 3 sir.infected
Set 1 Run 4 sir.resistant ==Set 1 Run 4 sir.infected ===Set 1 Run 5 sir.resistant ===Set 1 Run 5 sir.infected ===Set 1 Run 6 sir.resistant Set 1 Run 6 sir.infected
]

Sandia
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CASo0S
Engineering

.0b5
Community Virus

Interventions

Data can be averaged, and dumped to file

Simulate Help

fqatam Community .(\_m;amn: (lnt_e_ryer,tmns TSimnlﬂtinn =X

‘ Default Community - ‘

Outcome variables:

[1 [current number of people not receiving ativirals

[ Currert numier of people receiving antivirals.

[¥1] Current latert cases.

[ Current asymptometic cases:

[1 Current presymptomatic casss

[ Current circulating cases in syptomatic stage 1

[ Current eirculating cases in symptomstic stage 2

[ Current non-circulsting cases in symptomatic stage: 1

[T current non-ciniciating cases in symptomatic stage 2.

Population

[1 Cumulative cases of mortaity resuting fram infection.

[Z] Cumulstive number of resistant persons:

[ Current number of people circulating

[ Currert numiser of people not croulsting.

[1 Current number of susceptible persans.

1] Current number of infected persons (in any stage)

[l Current number of recovered or dead persans.

Other Options:

[¥] Display Means

Number of runs:

Infection

9,000

8,500

8,000

7,500

7,000

6,500

6,000

5,500

5,000

4,500

4,000

3,500

3,000

2,500

2,000

1,500

1,000

500

0.0

2.5 5.0 7.5 100 125 150  17.5

20.0 22,5 25.0 27.5 300 32.5 35.0 37.5 400 425 45.0
Day

= Set 1 sir.infected ==Set 1 inf.latent

Set 1 sir.resistant Set 1 antiviral.on

Clear

I Simulste
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cnses Example: The Effect of School Closures on
e Disease Propagation

Infection

=
2
et
2
=
o
(=
(=

== Set 1 sir.resistant == Set 1 sirinfected — Set 2 sir.resistant Set 2 sirinfected
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j Engineering EXtenS|OnS

. Investigation of the spread of correlated diseases and opinions.

. Investigation of the spread of multiple competitive and non-
competitive strains of influenza, including strains that are
resistant to neuraminidase inhibitors.

. Used for cost-effectiveness evaluation of mitigation strategies.

.- Implementation of a mechanism to retrieve census data based
upon GIS coordinates and construct characteristic communities.

¢% Veterans Health

Sandia
National 4 &
Laboratories %

H . . Modeling for Public Health Action
¢ Administration 9- 10 December 2010 24



(o)

J:‘%} CAS0S
. Engineering

Demos

Come see me for demos or if you're
interested in beta testing

Modeling for Public Health Action o5
9 - 10 December 2010
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2 Engineering Distribution and Release

\

- We intend to publicly release Loki-Infect 3 along with its source
code under a free license in the summer of 2011.

) % Veterans Health
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Questions?
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Additional slides
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‘('9‘!") CAS0S _ _
&Y =ronein Representation of a Community

. To construct a layer in the community, we begin by randomly
sampling the user-provided distributions to produce new
distributions.

- We then use these distributions as constraints in a linear least
squares problem, which we solve using a weighted non-
negative least squares algorithm.

- We then use a hill-climbing approach to produce a solution that
satisfies all necessary constraints (e.g., we must guarantee that
the sum of all members in all groups is consistent with the
demographics of the population).

- Repeatedly applying this approach to all layers produces a new
random community that necessarily satisfies all hard constraints
and roughly approximates all soft constraints.

Sandia #%ghh Veterans Health
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